Release Pack Campus.2040 -
September 2020

Last Modified on 11/20/2025 3:04 pm CST

Release notes provide the applicable personnel the ability to review enhancements, modifications,
and regulated changes prior to accepting an update. It is advised that users review the release
notes carefully and alert appropriate district staff to changes in Campus.

The Release Information article lists the approximate release date of all Campus.2044
2020 Campus releases. > Campus.2040
Campus.2036
See the Rx Pack - Campus.2040 article for a list of Rx releases to the Campus.2032
Campus.2040 release pack. Campus.2028

Questions or concerns regarding an update should be directed to
Campus Support.

See the Supported Platforms article for more information about supported technologies.

This release includes case SIS-140647 which has a long-running script that may extend
deployments. Districts updating to 2036.8 or higher can expect the first update to take
approximately 20% longer than standard due to a one-time script.

Update Manifest

See the Campus Release Pack Enhancements article for a list of just enhancement release notes.

Core Cases

Component Case Description
Number
Activity SIS- [Enhancement] Activity Registration Updates
Registration 140429
Ad hoc SIS- Ad Hoc Update for FRAM Data
Reporting 138308
Ad hoc SIS- Pivot Designer Incorrectly Requiring Modify Calendar Rights to
Reporting 139871 Properly View Pivot
Ad hoc SIS- Ad Hoc Error for Daily Health Log
Reporting 140757
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https://kb.infinitecampus.com/help/release-information
http://kb.infinitecampus.com/help/rx-pack-campus2040
http://kb.infinitecampus.com/help/release-pack-campus2044-october-2020
http://kb.infinitecampus.com/help/release-pack-campus2036-august-2020
http://kb.infinitecampus.com/help/release-pack-campus2032-august-2020
https://kb.infinitecampus.com/help/release-pack-campus2028-july-2020
https://kb.infinitecampus.com/help/supported-platforms
https://kb.infinitecampus.com/help/campus-release-pack-enhancements
http://kb.infinitecampus.com/#activity-registration-updates-sis-140429-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#ad-hoc-update-for-fram-data-sis-138308
http://kb.infinitecampus.com/#pivot-designer-incorrectly-requiring-modify-calendar-rights-to-properly-view-pivot-sis-139871
http://kb.infinitecampus.com/#ad-hoc-error-for-daily-health-log-sis-140757

API SIS- [Enhancement] Alpha APl and ORM Framework Update
140854
Attendance SIS- Period Detail Batch report termination error
137709
Blended SIS- Student Attendance - Virtual Group Icon Display
Learning 140425
Blended SIS- [Enhancement] Virtual Attendance Preferences - Warning
Learning 140472 When Modifying Preferences
Blended SIS- Virtual Attendance - Student Check Ins
Learning 140520
Blended SIS- [Enhancement] Student Profile - Blended Learning Group
Learning 138415 Display
Blended SIS- Section Roster Report - Blended Learning Group Option
Learning 140108
Blended SIS- [Enhancement] Blended Learning Updates
Learning 140336
Blended SIS- Blended Learning Ad hoc Fields - virtualToday and
Learning 140354 virtualTomorrow
Blended SIS- Section Roster Report - Blended Learning Group Counts
Learning 140455
Blended SIS- Multiple Blended Learning Groups with no End Date
Learning 140598
Blended SIS- Calendar Day - Blended Learning Groups
Learning 139960
Blended SIS- [Enhancement] Blended Learning - Instruction Changes &
Learning 140863 Campus Student and Parent
Blended SIS- Blended Learning - Adjust Day Rotation with Multiple Calendars
Learning 141112
Campus SIS- Report Cards - Sort Order
Instruction 135109
Campus SIS- Roster Report
Instruction 135445
Campus SIS- Portal Usage Report - Summary & Detail
Instruction 135968
Campus SIS- Roster Label Report
Instruction 137361

Page 2


http://kb.infinitecampus.com/#alpha-api-and-orm-framework-update-sis-140854-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#attendance%E2%80%93-period-detail-batch-report-termination-error-sis-137709
http://kb.infinitecampus.com/#student-attendance---virtual-group-icon-display-sis-140425
http://kb.infinitecampus.com/#virtual-attendance-preferences---warning-when-modifying-preferences-sis-140472-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#virtual-attendance---student-check-ins-sis-140520
http://kb.infinitecampus.com/#student-profile---blended-learning-virtual-indicator-sis-138415-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#section-roster-report---blended-learning-group-option-sis-140108
http://kb.infinitecampus.com/#blended-learning-updates-sis-140336-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#blended-learning-ad-hoc-fields---virtualtoday-and-virtualtomorrow-sis-140354
http://kb.infinitecampus.com/#section-roster-report---blended-learning-group-counts-sis-140455
http://kb.infinitecampus.com/#multiple-blended-learning-groups-with-no-end-date-sis-140598
http://kb.infinitecampus.com/#calendar-day---blended-learning-groups-sis-139960
http://kb.infinitecampus.com/#blended-learning---instruction-changes-&-campus-student-and-parent-sis-140863-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#blended-learning---adjust-day-rotation-with-multiple-calendars-sis-141112
http://kb.infinitecampus.com/#report-cards---sort-order-sis-135109
http://kb.infinitecampus.com/#roster-report-sis-135445
http://kb.infinitecampus.com/#portal-usage-report---summary-&-detail-sis-135968
http://kb.infinitecampus.com/#roster-label-report-sis-137361

Campus SIS- Advisory - Last Day of the Year

Instruction 139293

Campus SIS- Advisory - Assignments with a Score of 0
Instruction 140431

Campus SIS- Blank Spreadsheet

Instruction 140434

Campus SIS- Attendance Comments in Seating Charts
Instruction 141172

Campus SIS- [Enhancement] LTI Configuration - Multiple Connections
Learning 138792

Campus SIS- [Enhancement] LTI Configuration - Launch Types
Learning 139914

Campus SIS- Portal Usage Report - Average Logins

Student/Parent 130376

Campus SIS- Campus Student & Parent
Student/Parent 140143

Census SIS- Census Wizard - Access to Step 3
140159
Custom SIS- [Enhancement] Custom Tool Placement Editor Now Available
137452
Data Extract SIS- Data Extract Utility - District Names
Utility 140841
DIS/SIF SIS- SIF StudentSchoolEnroliment Logic Update
139073
DIS/SIF SIS- Resync State Data Tool Failing to Properly Sync Day Object
140486
Ed-Fi SIS- Ed-Fi Update
140605
FRAM SIS- FRAM Verification Summary Report Update
122979
FRAM SIS- Summary Report Updates
125918
Grades SIS- [Enhancement] Grading Window - Notifications Warning
Reporting 140073
Grades SIS- Grading Window - Update Script
Reporting 140475

Page 3


http://kb.infinitecampus.com/#advisory---last-day-of-the-year-sis-139293
http://kb.infinitecampus.com/#advisory---assignments-with-a-score-of-0-sis-140431
http://kb.infinitecampus.com/#blank-spreadsheet-sis-140434
http://kb.infinitecampus.com/#attendance-comments-in-seating-charts-sis-141172
http://kb.infinitecampus.com/#lti-configuration---multiple-connections-sis-138792-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#lti-configuration---launch-types-sis-139914-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#portal-usage-report---average-logins-sis-130376
http://kb.infinitecampus.com/#campus-student-&-parent-sis-140143
http://kb.infinitecampus.com/#census-wizard---access-to-step-3-sis-140159
http://kb.infinitecampus.com/#custom-tool-placement-editor-now-available-sis-137452-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#data-extract-utility---district-names-sis-140841
http://kb.infinitecampus.com/#sif-studentschoolenrollment-logic-update-sis-139073
http://kb.infinitecampus.com/#resync-state-data-tool-failing-to-properly-sync-day-object-sis-140486
http://kb.infinitecampus.com/#ed-fi-update-sis-140605
http://kb.infinitecampus.com/#fram-verification-summary-report-update-sis-122979
http://kb.infinitecampus.com/#summary-report-updates-sis-125918
http://kb.infinitecampus.com/#grading-window---notifications-warning-sis-140073-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#grading-window---update-script-sis-140475

Grades

Reporting

Health

Health

Learner Planning

Learner Planning

Navigation

Navigation

OneRoster

OneRoster

Online Payments

Point of Sale

Records Transfer

RTI

Scheduling

Scheduling

School Choice

School Store

School Store

SIS-
140730

SIS-
136287

SIS-
140381

SIS-
139646

SIS-
140368

SIS-
138378

SIS-
140565

SIS-
124095

SIS-
140647

SIS-
139701

SIS-
118404

S1S-64243

SIS-
140242

SIS-
140621

SIS-
140838

SIS-
127048

SIS-
138893

SIS-
138918

Grading Window - Incorrect Date Display

Health Office Visits Fix

Daily Health Log Update

Special Ed Caseload Sort Update

Special Ed Team Members Performance Update

[Enhancement] Household and Course/Section Search Panels

Added to New Look of Infinite Campus

Classic Campus Navigation Working Incorrectly When District

Announcement Contains Embedded iFrame

Expiration Notifications

OneRoster - dateLastModified

My Cart Checkout Screen Update

Mass Account Creation Update

EL Import Update

RTI Plan Fix

Guest Access to Grade Book

Walk-In Scheduler - Section Placement Error

[Enhancement] School Choice Reports Available in DOCX

[Enhancement] Ability to View School Store Purchases in

Census

[Enhancement] New Option to Delete Unused Categories and
Products
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http://kb.infinitecampus.com/#grading-window---incorrect-date-display-sis-140730
http://kb.infinitecampus.com/#health-office-visits-fix-sis-136287
http://kb.infinitecampus.com/#daily-health-log-update-sis-140381
http://kb.infinitecampus.com/#special-ed-caseload-sort-update-sis-139646
http://kb.infinitecampus.com/#special-ed-team-members-performance-update-sis-140368
http://kb.infinitecampus.com/#household-and-course/section-search-panels-added-to-new-look-of-infinite-campus-sis-138378-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#classic-campus-navigation-working-incorrectly-when-district-announcement-contains-embedded-iframe-sis-140565
http://kb.infinitecampus.com/#oneroster---expiration-notifications-sis-124095
http://kb.infinitecampus.com/#oneroster---datelastmodified-sis-140647
http://kb.infinitecampus.com/#my-cart-checkout-screen-update-sis-139701
http://kb.infinitecampus.com/#mass-account-creation-update-sis-118404
http://kb.infinitecampus.com/#el-import-update-sis-64243
http://kb.infinitecampus.com/#rti-plan-fix-sis-140242
http://kb.infinitecampus.com/#guest-access-to-grade-book-sis-140621
http://kb.infinitecampus.com/#walk-in-scheduler---section-placement-error-sis-140838
http://kb.infinitecampus.com/#school-choice-reports-available-in-docx-sis-127048-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#ability-to-view-school-store-purchases-in-census-sis-138893%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#new-option-to-delete-unused-categories-and-products-sis-138918-%5Benhancement%5D%C2%A0

School Store SIS- [Enhancement] Update for Including Multiple Schools in One
139892 Orders Report

School Store SIS- [Enhancement] Partial Refunds for School Store Products
139945

School Store SIS- School Store Image Update
140334

School Store SIS- School Store Reports Update
140436

School Store SIS- Purchase Limit Cache Update for Multiple Application Server
140466 Environments

School Store SIS- [Enhancement] School Store and Category Screen
140568 Restructure

School Store SIS- New Warning when Importing File for Product Items
140674

Search SIS- [Enhancement] Search Framework Error Process Alert
129400 Message

Search SIS- [Enhancement] Search Framework Status Tool Now Available
130453

Security SIS- Audit Log Failing to Show Disabled or Change User Accounts
140009

Security SIS- Disabled LDAPS Profiles Incorrectly Allowed to Connect
140718

Student SIS- Photo Import Producing Errors
129931

Surveys SIS- [Enhancement] Completely Redesigned Survey Designer Tool
137797 Now Available

Transcript SIS- [Enhancement] Removal of Classic Transcript
140963

WYSIWYG SIS- WYSIWYG Editors - Pasting Text from MS Word
136180

State-Specific Cases

State Case Description
Number

Arizona SIS- ESS DDC Extract Now Available
138747
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http://kb.infinitecampus.com/#update-for-including-multiple-schools-in-one-orders-report-sis-139892-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#partial-refunds-for-school-store-products-sis-139945-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#school-store-image-update-sis-140334
http://kb.infinitecampus.com/#school-store-reports-update-sis-140436
http://kb.infinitecampus.com/#purchase-limit-cache-update-for-multiple-application-server-environments-sis-140466
http://kb.infinitecampus.com/#school-store-and-category-screen-restructure-sis-140568-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#new-warning-when-importing-file-for-product-items-sis-140674
http://kb.infinitecampus.com/#search-framework-error-process-alert-message-sis-129400-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#search-framework-status-tool-now-available-sis-130453-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#audit-log-failing-to-show-disabled-or-change-user-accounts-sis-140009
http://kb.infinitecampus.com/#disabled-ldaps-profiles-incorrectly-allowed-to-connect-sis-140718
http://kb.infinitecampus.com/#photo-import-producing-errors-sis-129931
http://kb.infinitecampus.com/#completely-redesigned-survey-designer-tool-now-available%0A-sis-137797-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#removal-of-classic-transcript-sis-140963-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#wysiwyg-editors---pasting-text-from-ms-word-sis-136180
http://kb.infinitecampus.com/#arizona-%E2%80%93-ess-ddc-extract-now-available-sis-138747

Arizona SIS- [Enhancement] Attendance Extract Now Available
139197
Arizona SIS- Ed-Fi v3.3 Student Special Education Program Association
140677 Update
Arizona SIS- Ed-Fi - New 21st CCLC Code
140772
BIE SIS- [Enhancement] New BIE Documents tab available
133543
BIE SIS- Special Ed Updates
139650
BIE SIS- Goal Monitoring Fix
140386
BIE SIS- Special Ed Setting Update
140502
California SIS- EL Services Update Script
140474
California SIS- New Program for Tribal Foster Youth
140671
Colorado SIS- Evaluation Update
139265
Colorado SIS- Student Interchange - Course Completion
139312
Colorado SIS- VE-135 File - Program Level
140048
Colorado SIS- Student Layout - Primary Nighttime Residence
140900
Georgia SIS- Evaluation Update
140190
Georgia SIS- IEP Bug Fix
140587
Georgia SIS- IEP Update
140989
Hawaii SIS- Gifted and Talented Documents
140599
Hawaii SIS- Adjudicated Source(s)
140701
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http://kb.infinitecampus.com/#arizona-%E2%80%93-attendance-extract-now-available-sis-139197-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#arizona---ed-fi-v3.3-student-special-education-program-association-update-sis-140677
http://kb.infinitecampus.com/#arizona-%E2%80%93-ed-fi-%E2%80%93-new-21st-cclc-code-sis-140772
http://kb.infinitecampus.com/#bie%E2%80%93-new-bie-documents-tab-available-sis-133543-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#bie-special-ed-updates-sis-139650
http://kb.infinitecampus.com/#bie-goal-monitoring-fix-sis-140386
http://kb.infinitecampus.com/#bie-special-ed-setting-update-sis-140502
http://kb.infinitecampus.com/#california---el-services-update-script-sis-140474
http://kb.infinitecampus.com/#california---new-program-for-tribal-foster-youth-sis-140671
http://kb.infinitecampus.com/#colorado-evaluation-update-sis-139265
http://kb.infinitecampus.com/#colorado--student-interchange---course-completion-colorado-\(sis-139312\)
http://kb.infinitecampus.com/#colorado---ve-135-file---program-level-sis-140048
http://kb.infinitecampus.com/#colorado---student-layout---primary-nighttime-residence-sis-140900
http://kb.infinitecampus.com/#georgia-evaluation-update-sis-140190
http://kb.infinitecampus.com/#georgia-iep-bug-fix-sis-140587
http://kb.infinitecampus.com/#georgia-iep-update-sis-140989
http://kb.infinitecampus.com/#hawaii---gifted-and-talented-documents-sis-sis-140599
http://kb.infinitecampus.com/#hawaii---adjudicated-sources-\(sis-140701\)

Hawaii SIS- New Fields on Impact Aid Report
140899

Hawaii SIS- GT Status Description Update
141021

Idaho SIS- ISEE Staff Demographics Extract Update
140430

Idaho SIS- Border Student Conversion
140476

lllinois SIS- ISBE Regional Safe Schools Program
136650

lllinois SIS- State Reporting Removed/Renamed Extracts
138958

Illinois SIS- ISBE Gifted and Accelerated - Home School
139484

Illinois SIS- EL Service Types
139744

Illinois SIS- New Language Codes
140268

Indiana SIS- TA Extract Update
135198

Indiana SIS- GR (Graduate Report) Update
139176

Indiana SIS- ME Report Update for Reporting COVID-19 Virtual
139508

Indiana SIS- Changes for West Clark District Separation
140064

Indiana SIS- Digital Equity
140493

Kansas SIS- Migrant Logic on KCAN Extract
140302

Kansas SIS- Start/End Dates on Student Migrant Tool
140768

Kentucky SIS- [Enhancement] EL Documents Custom Forms Module Added
133754

Kentucky SIS- Custom Form Updates
139752
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http://kb.infinitecampus.com/#hawaii---new-fields-on-impact-aid-report-sis-140899
http://kb.infinitecampus.com/#hawaii---gt-status-description-update-sis-141021
http://kb.infinitecampus.com/#idaho---isee-staff-demographics-extract-update-sis-140430
http://kb.infinitecampus.com/#idaho---border-student-conversion-sis-140476
http://kb.infinitecampus.com/#illinois---isbe-regional-safe-schools-program-sis-136650
http://kb.infinitecampus.com/#illinois---state-reporting-removed/renamed-extracts-sis-138958
http://kb.infinitecampus.com/#illinois---isbe-gifted-and-accelerated---home-school-sis-139484
http://kb.infinitecampus.com/#illinois---el-service-types-sis-139744
http://kb.infinitecampus.com/#illinois---new-language-codes-sis-140268
http://kb.infinitecampus.com/#indiana---ta-extract-update-sis-135198
http://kb.infinitecampus.com/#indiana---gr-graduate-report-update-\(sis-139176\)
http://kb.infinitecampus.com/#indiana---me-report-update-for-reporting-covid-19-virtual-sis-139508
http://kb.infinitecampus.com/#indiana---changes-for-west-clark-district-separation-sis-140064
http://kb.infinitecampus.com/#indiana---digital-equity-sis-140493
http://kb.infinitecampus.com/#kansas---migrant-logic-on-kcan-extract-sis-140302
http://kb.infinitecampus.com/#kansas---start/end-dates-on-student-migrant-tool-sis-140768
http://kb.infinitecampus.com/#kentucky-%E2%80%93-el-documents-custom-forms-module-added-sis-133754-%5Benhancement%5D%C2%A0
http://kb.infinitecampus.com/#kentucky-custom-form-updates-sis-139752

Kentucky SIS- Student Participation Report Now Available
140250

Kentucky SIS- Duration in School Days Not Auto-Calculating
140551

Kentucky SIS- Users Unable to Save TEDS Records
140682

Maine SIS- 2020-2021 School Year Updates
137005

Maine SIS- Immunization Update
140552

Maryland SIS- Non-Binary Gender
140325

Maryland SIS- Student Record Card 3 and MHSA Field Update
140626

Massachusetts = SIS- 2020-2021 Updates
138465

Massachusetts = SIS- 2020-2021 SIF Updates
140482

Massachusetts = SIS- Immunization Update
140501

Massachusetts = SIS- MA Instruction Mode Tool Added
140833

Michigan SIS- Ed-Fi v3.1 Update
135218

Michigan SIS- Student Record Maintenance Updates
138870

Minnesota SIS- Evaluation Type Added
139485

Minnesota SIS- Ed-Fi Student Early Education Program Associations Resource
140308 Update

Minnesota SIS- Updated District List
140670

Missouri SIS- MOSIS Student Enrollment and Attendance
139802

Missouri SIS- MOSIS Student Core Extract - Teacher Name
139983
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http://kb.infinitecampus.com/#maine-%E2%80%93-2020-2021-school-year-updates-sis-137005
http://kb.infinitecampus.com/#maine-immunization-update-sis-140552
http://kb.infinitecampus.com/#maryland---non-binary-gender-sis-140325
http://kb.infinitecampus.com/#maryland---student-record-card-3-and-mhsa-field-update-sis-140626
http://kb.infinitecampus.com/#massachusetts-%E2%80%93-2020-2021-updates-sis-138465
http://kb.infinitecampus.com/#massachusetts-%E2%80%93-2020-2021-sif-updates-sis-140482
http://kb.infinitecampus.com/#massachusetts-immunization-update-sis-140501
http://kb.infinitecampus.com/#massachusetts-%E2%80%93-ma-instruction-mode-tool-added-sis-140833
http://kb.infinitecampus.com/#michigan-%E2%80%93-ed-fi-v3.1-update-sis-135218
http://kb.infinitecampus.com/#michigan---student-record-maintenance-updates-sis-138870
http://kb.infinitecampus.com/#minnesota-evaluation-type-added-sis-139485
http://kb.infinitecampus.com/#minnesota---ed-fi-student-early-education-program-associations-resource-update-sis-140308
http://kb.infinitecampus.com/#minnesota---updated-district-list-sis-140670
http://kb.infinitecampus.com/#missouri---mosis-student-enrollment-and-attendance-sis-139802
http://kb.infinitecampus.com/#missouri---mosis-student-core-extract---teacher-name-sis-139983

Missouri SIS- MOSIS Student Core, New Digital Equity Tool
140099

Missouri SIS- IEP Updates
140309

Missouri SIS- UniquelD Extract School Code
140700

Montana SIS- MT Data Upload Validation Message Updated
138824

Montana SIS- [Enhancement] State Reported Data State Edition Update
138833

Montana SIS- Upload Date Added to Person Picture
139004

Montana SIS- MT Data Upload Store Location Producing Error
139097

Montana SIS- Enrollment Screen and State Reporting Updates
139670

Montana SIS- Special Ed IEP Updates
140161

Montana SIS- Special Ed Custom Forms Updates
140453

Montana SIS- Product Security Role Report to Include Montana Edition Details
140484

Montana SIS- Edition State Reported Data Script
140810

Nebraska SIS- Ed-Fi Discipline Duration Update
139776

Nebraska SIS- School of Assignment and Home School Fields Updates
140339

Nevada SIS- Start Status and End Status Codes
139574

New Mexico SIS- 20-21 State Programs and Programs Fact Changes
139660

New Mexico SIS- Report Updates for 2020-21 School Year
139661

New York SIS- CTE Program CHAMP Added to State Program Code
139799
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http://kb.infinitecampus.com/#montana-edition-state-reported-data-script-sis-140810
http://kb.infinitecampus.com/#nebraska---ed-fi-discipline-duration-update-sis-139776
http://kb.infinitecampus.com/#nebraska-%E2%80%93-school-of-assignment-and-home-school-fields-updates-sis-140339
http://kb.infinitecampus.com/#nevada---start-status-and-end-status-codes-sis-139574
http://kb.infinitecampus.com/#new-mexico---20-21-state-programs-and-programs-fact-changes-sis-139660
http://kb.infinitecampus.com/#new-mexico---report-updates-for-2020-21-school-year-sis-139661
http://kb.infinitecampus.com/#new-york---cte-program-champ-added-to-state-program-code-sis-139799

New York

New York

Ohio

Ohio

Ohio

Pennsylvania

Pennsylvania

Pennsylvania

Rhode Island

Rhode Island

Rhode Island

South Dakota

Tennessee

Texas

Texas

Utah

Utah

Utah

SIS-
140010

SIS-
140113

SIS-
139200

SIS-
139563

SIS-
140129

SIS-
139858

SIS-
140382

SIS-
140529

SIS-
140624

SIS-
140931

SIS-
141074

SIS-
140165

SIS-
140620

SIS-
140000

SIS-
140519

SIS-
137415

SIS-
140768

SIS-
140868

Immunization Update

State Program Code 1232 Added

Test Type IPD

Birth Country List

Special Ed Update

State Reporting, Enrollment Updates

IEP Update

Immunization Update

State Attendance Codes

New Program Codes for 2020-21

Enrollment Census Core - School Home Field

Immunization Update

EIS 060 & 062 Updates

Blended Learning ‘Remote Learning Type’ field added to the

Group Day Rotation screen for TX only

20/21 Crisis Reporting updates with new Crisis Event tab

SIF Updates

Start/End Dates on Student Migrant Tool

SIF StudentAcademicRecord Performance Issue
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http://kb.infinitecampus.com/#utah---sif-updates-sis-137415
http://kb.infinitecampus.com/#kansas---start/end-dates-on-student-migrant-tool-sis-140768
http://kb.infinitecampus.com/#utah-%E2%80%93-sif-studentacademicrecord-performance-issue-sis-140868

Vermont SIS- Homeless Data Added to Ad Hoc
134999
Virginia SIS- Update for Default Template on Transcript
139868
Wisconsin SIS- Ed-Fi School ID Removal
136090
Wisconsin SIS- Ed-Fi Digital Equity Update
140427
Wisconsin SIS- State Reporting Fields and Validations Added to Student Locator
140511
Wisconsin SIS- WISEid Import
141070
Wyoming SIS- Learning Methods
140869

Technical Information

See the Technical Information - Release Pack Campus.2040 article for a list of schema changes in
this release.

Activity Registration
Activity Registration Updates (SIS-140429) [Enhancement]
The following changes were made for Activity Registration.

¢ A new tool was added for managing School Store and Activity Registration Categories.
Previously, Categories for these modules were managed in separate tools. The new
Categories tool can be found in School Store > Administration > Categories. As part of this
change, School Store Products and Activities can be assigned to the same Category.

¢ A new checkbox called "Restrict to Associated School Enrollments" was added to "Step 4 -
Link to Portal" in the Activity Builder. When this checkbox is marked, the Recipient dropdown
list in the School Store will only display students who have an enrollment in the active school
year for the school associated to the activity. This includes primary, secondary, and end dated
enrollments.

e A new checkbox called "Partial Refunds" was added to "Step 4 - Link to Portal" in the Activity
Builder. When this checkbox is marked, partial refunds can be issued in the Payments
Reporter for the activity.

o If the activity has the "Track Limits" option turned on, a new checkbox called "Return to
Inventory" now displays when completing a full or partial refund. When this checkbox is
marked, Campus will return the activity to the inventory you have available.

e The Activity Name can now be changed until registration closes. Please note that if you
change the Activity Name, any completed purchases/registrations that exist when you change

Page 11


http://kb.infinitecampus.com/#vermont---homeless-data-added-to-ad-hoc-sis-134999
http://kb.infinitecampus.com/#virginia--update-for-default-template-on-transcript-sis-139868
http://kb.infinitecampus.com/#wisconsin---ed-fi-school-id-removal-sis-136090
http://kb.infinitecampus.com/#wisconsin---ed-fi-digital-equity-update-sis-140427
http://kb.infinitecampus.com/#wisconsin-%E2%80%93-state-reporting-fields-and-validations-added-to-student-locator-sis-140511
http://kb.infinitecampus.com/#wisconsin---wiseid-import-sis-141070
http://kb.infinitecampus.com/#wyoming---learning-methods-sis-140869
http://kb.infinitecampus.com/help/technical-information-release-pack-campus2040

the name will still use the original name (name at the time the purchase was made) in School
Store reports.

e For districts using the new looks and feel of Campus, a new menu item called Product
Inventory was added in the School Store. The Product Inventory menu includes the Activity
Monitor for Activity Registration. The Activity Monitor can also be accessed in Student
Information > Activity Registration > Activity monitor. For districts still using classic Campus,
the Activity Registration tool location has not changed.

e Miscellaneous changes were made for improved performance and for improving the user's
experience.

Article(s): Activity Builder; Activity Monitor; Categories (School Store)

Path: Activity Registration > Activity Monitor; School Store > Administration > Categories

Ad hoc Reporting

Ad Hoc Update for FRAM Data (SI1S-138308)

Some users saw an error when trying to retrieve a large amount of FRAM data. This issue was
corrected.

Article(s): N/A

Path: N/A

Pivot Designer Incorrectly Requiring Modify Calendar Rights to Properly View Pivot (S1S-139871)

Pivots saved to user groups were incorrectly displaying without configured Fields options for users
with only read-rights to the calendar. This issue was corrected.

Article(s): Pivot Designer

Path: Ad Hoc Reporting > Pivot Designer

Ad Hoc Error for Daily Health Log (S1S-140757)

An error was occurring when running an Ad Hoc Filter with custom attributes for the Daily Health
Log. This issue has been resolved.

Article(s): N/A

Path: Ad Hoc > Filter Designer

API
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Alpha APl and ORM Framework Update (S1S-140854) [Enhancement]

An update to the Alpha APl and ORM framework was applied. This update corrects an issue some
districts were seeing with incorrect counts on the x-total-count and paging headers. This issue only
impacted environments with more than one instance of the Infinite Campus application on the
same server, and only when the environment was configured with more than one server. This
issue primarily impacted districts utilizing the OneRoster 1.x API.

Article(s): N/A

Path: No Specific Path

Attendance

Attendance- Period Detail Batch report termination error (SIS-137709)

A termination error was returned when the Period Detail Batch report was generated with only the
‘Period Summary’ reporting option selected. The issue was related to students with a
Status/Excuse code not included in the Period Summary count and has been fixed. The work-
around to include Course Summary or any of the other options to resolve the error and run the
report are no longer needed.

Article(s): Period Detail Batch

Path: Attendance > Reports > Period Detail Batch

Blended Learning

See the Blended Learning Release Notification for additional information.

Student Attendance - Virtual Group Icon Display (SIS-140425)

When a student is assigned to a virtual Blended Learning Group, the virtual group icon displays for
all attendance records.

Article(s): Student Attendance

Path: Student Information > General > Attendance

Virtual Attendance Preferences - Warning When Modifying Preferences (SI1S-140472)
[Enhancement]

A warning has been added when the Virtual Attendance Posting Preference is enabled and
students may not have Student Participation records for dates after the Attendance Posting Start
Date because Participation-based Entry was not enabled.
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When Virtual Attendance Posting is enabled and saved in a calendar where Participation-based
entry of Virtual Attendance was not enabled in the range between the Attendance Posting Start
date and the Posting Job Start date, a warning displays that indicates the following:

e The Attendance Posting Code will be applied to EVERY period from the Attendance Posting
Start Date forward for virtual students.
e Teacher-entered attendance will be removed.

Article(s): Virtual Attendance Preferences

Path: System Administration > Attendance > Virtual Attendance Preferences

Virtual Attendance - Student Check Ins (S1S-140520)

An issue has been corrected where a teacher taking attendance incorrectly overwrote the
student's participation check in.

Article(s): Attendance

Path: Instruction > Attendance

Student Profile - Blended Learning Virtual Indicator (SIS-138415) [Enhancement]

A virtual indicator now displays on the Attendance Card when viewing the details of an attendance
record when the student is attending school virtually on any given day.

Article(s): Profile

Path: Student Information > General > Profile

Section Roster Report - Blended Learning Group Option (SIS-140108)

An error occurred when generating the Section Roster Report with no Student Options marked and
the Blended Learning Group Summary option marked. This has been corrected.

Also, a Blended Learning Group with a long name now wraps in the report header.

Article(s): Section Roster Report

Path: Scheduling > Courses > Course > Section > Roster; Scheduling > Reports > Section Rosters

Blended Learning Updates (SIS-140336) [Enhancement]

New features have been added to the Blended Learning tools:
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Scheduling Blended Learning Tools

e Entering any part of a calendar name now returns matching options for all of the calendar
selection fields.

Student Attendance

e The total number of students currently assigned to a group is now listed in parentheses when
updating a group assignment.

e An End Group Assignment option has been added. Enter an Effective Date to indicate the
LAST DAY the student is assigned to the current group. Future dates and the current date can
be entered, but past dates cannot be entered.

e When a student is not currently assigned to a learning group, but is assigned to a group in the
future, the start date of that group displays.

The following modifications have been made to Blended Learning Tools:

e When Creating New Blended Learning Groups or Adjusting Blended Learning Groups, the
validation messages that display are now consistent between the two processes.

e The Adjust Blended Learning Groups interface has been updated slightly. Fields have been
relocated for ease of use.

e Editing a group (modifying the group color and name) can no longer be done when using the
Adjust Learning Groups tool. This option can only be done when using the New Blended
Learning Groups tool.

e Performance for creating Blended Learning tools has been optimized.

Article(s): Student Attendance; New Blended Learning Groups; Adjust Blended Learning Groups

Path: Student Information > General > Attendance; Scheduling > Blended Learning

Blended Learning Ad hoc Fields - virtualToday and virtualTomorrow (SI1S-140354)

The virtualToday and virtualTomorrow fields were incorrectly using all of the student's active
enrollments, instead of just the calendar selected in the toolbar. This has been corrected.

Article(s): New Blended Learning Groups

Path: Ad hoc Reporting > Filter Designer; Scheduling > Blended Learning Groups

Section Roster Report - Blended Learning Group Counts (SIS-140455)

Blended Learning Group Summary values were different when the Section Roster Report was
generated from the Section Roster tool than from the Scheduling Section Roster Report. This has
been corrected.

Article(s): Section Roster Report; Roster (Section)
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Path: Scheduling > Reporting > Section Roster Report; Scheduling > Courses > Course > Section
> Roster > Roster Print Options

Multiple Blended Learning Groups with no End Date (S1S-140598)

A modification to Blended Learning Groups has been made that prohibits the assignment of
multiple Blended Learning Groups with different start dates without one group having an end date.
With this modification, the correct end date is updated for the current group assignment record.

A student can only have one future group assignment.
Article(s): N/A

Path: Scheduling > Blended Learning Groups

Blended Learning - Instruction Changes & Campus Student and Parent (S1S5-140863)
[Enhancement]

The following updates have been made in Instruction to support Blended Learning:

e The Roster, Student Groups, and the Message Center have been updated so that the blended
learning group that displays for students is the one that is active during the term selected in
the Campus toolbar.

e Seating Charts has been updated so that the blended learning group that displays is the one
that is active for the section.

¢ Printed Planner Roster report has been updated to show blended learning groups.

Additionally, a new Virtual Attendance Preference has been added called 'Indicate that attendance
was taken when a teachers saves participation for a previous day.' If this preference is marked,
when a teacher saves participation for a section for a previous day, the Classroom Monitor and
Attendance screens will indicate that attendance has been taken for that day.

The following updates have been made to Campus Student and Campus Parent:

¢ A new preference has been added to the Display Options to display the student's Blended
Learning Group on the Today screen.

¢ (Kentucky only) A log of student responses to check-ins now displays, as is shown in other
states.

e Check-in data for all states now displays in a side panel, instead of mixing the data in with
attendance.

Article(s): Roster, Student Groups, Message Center, Virtual Attendance Preferences, Campus
Student, Campus Parent

Path: Campus Instruction > Roster Student Groups, Message Center; System Administration >
Attendance > Virtual Attendance Preferences; Campus Student; Campus Parent
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Blended Learning - Adjust Day Rotation with Multiple Calendars (SI1S-141112)

Modifying the Group Day Assignment for multiple calendars now correctly adjusts the Calendar
Day to the updated group for ALL selected calendars.

Article(s): Adjust Blended Learning Groups

Path: Scheduling > Blended Learning > Adjust Blended Learning Groups

Calendar Day - Blended Learning Groups (SI1S-139960)

When modifying Day Attributes for a previous day, the associated Blended Learning Group was
removed from that day. This has been corrected.

Article(s):Calendar Days

Path: System Administration > Calendar > Calendar > Days

Campus Instruction

Report Cards - Sort Order (S1S-135109)

Previously, when printing a Report Card in Campus Instruction, the list of report card templates
was not sorted alphabetically. This has been corrected.

Article(s): Report Card (Instruction)

Path: Campus Instruction > Reports > Report Card

Roster Report (SIS-135445)
The Roster report has been updated so that the period of the section displays in the report.

Article(s): Roster Report

Path: Campus Instruction > Reports > Roster

Portal Usage Report - Summary & Detail (S1S-135968)

Previously, when generating the Detail mode of the Portal Usage Report, the correct mode
generated but was labeled as Summary. This has been corrected.

Article(s): Portal Usage Report
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Path: System Administration > Portal > Reports > Portal Usage

Roster Label Report (SIS-137361)

Previously, the Roster Label report always included Guardian names if generated in DOCX format.
This has been corrected.

Article(s): Roster Labels

Path: Campus Instruction > Reports > Roster Labels

Advisory - Last Day of the Year (S1S-139293)

Previously, users were unable to access the Advisory tool on the last day of the school calendar.
This has been corrected.

Article(s): Advisory

Path: Campus Instruction > Advisory

Advisory - Assignments with a Score of 0 (S1S-140431)

Previously, assignments with a score of O were listed in the No Score list in the Assignment Details.
This has been corrected.

Article(s): Advisory

Path: Campus Instruction > Advisory

Blank Spreadsheet (SIS-140434)

Previously, some users encountered an error when attempting to run the Blank Spreadsheet report
for multiple sections with overlapping students. This has been corrected.

Article(s): Blank Spreadsheet

Path: Campus Instruction > Reports > Blank Spreadsheet

Attendance Comments in Seating Charts (SIS-141172)

Previously, users were unable to add attendance comments when recording attendance via the
seating chart. This has been corrected.
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Article(s): Taking Attendance via the Seating Chart

Path: Campus Instruction > Attendance > Seating Chart

Campus Learning

LTI Configuration - Multiple Connections (S1S-138792) [Enhancement]

The Learning Interoperability/Digital Learning Applications tool has been updated to allow users to
set up multiple connections for a single application, so that different schools or groups of schools
within the district can have separate connections. Each school can only be selected for one
connection per provider.

Article(s): LTI Configuration

Path: System Administration > Learning Interoperability/Digital Learning Applications > select an
LTI partner

LTI Configuration - Launch Types (SIS-139914) [Enhancement]

Digital Learning partners configured for Learning Tool Interoperability (LTI) have been updated to
include lozenges that indicate how resources from the partner can be launched. These options
include:

e |earning Tool - displays in Learning Tools in Instruction.
e Assignment Resource - resources can be aligned to specific assignments.

Article(s): LTI Configuration

Path: System Administration > Learning Interoperability/Digital Learning Applications > click an LTI
partner

Campus Student & Parent

Portal Usage Report - Average Logins (S1S-130376)

Previously, the average weekly logins column of the Portal Usage Report was not displaying
correct results. This has been corrected.

Article(s): Portal Usage Report

Path: System Administration > Portal > Reports > Portal Usage

Campus Student & Parent (S1S-140143)

Continuing security improvements have been made to Campus Student and Campus Parent.
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Article(s): Campus Student, Campus Parent

Path: Campus Student, Campus Parent

Census

Census Wizard - Access to Step 3 (S15-140159)

The ability to move from Step 2, Assemble New or Select Existing Household, to Step 3, Edit
Membership and Mailing Information, was not working and users could not complete the setup of
households. This has been corrected.

Article(s): Census Wizard

Path: Census > Census Wizard

Custom
Custom Tool Placement Editor Now Available (SIS-137452) [Enhancement]

The Custom Tool Placement Editor is now available. This tool allows users to customize where in
the new Campus navigation Ul their custom tools will live. Users can either place their custom
tools within existing menu items and categories or customize and create their own menu items
and categories.

Districts and Channel Partners: Please use this tool to ensure your custom tools are organized and
located in their proper places.

Article(s): Custom Tool Placement Editor

Path: System Administration > Custom > Custom Tool Placement Editor

Data Extract Utility

Data Extract Utility - District Names (S1S-140841)

The Data Extract Utility has been updated to accommodate districts on the same app server who
scheduled the same extract at the same time with the same extension.

Article(s): Data Extract Utility

Path: No Specific Path

DIS/SIF

SIF StudentSchoolEnrollment Logic Update (SIS-139073)

IA and OK users only: Logic for the StudentSchoolEnrollment/MembershipType element has been
updated to report a value of ‘Summer’ if the student’s enrollment record is in a calendar where
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Summer School = checked.

Article(s): Oklahoma (SIF); lowa (SIF)

Path: No Specific Path

Resync State Data Tool Failing to Properly Sync Day Object (S1S-140486)

A bug was preventing the Day object from properly syncing via the Resync State Data tool. This
issue was corrected.

Article(s): Resync State Data

Path: System Administration > Data Utilities > Resync State Data

Ed-Fi
Ed-Fi Update (SIS-140605)

A previous Ed-Fi v3 file that was preventing some student level data from sending has been
removed.

Article(s): N/A

Path: System Administration > Ed-Fi

FRAM

FRAM Verification Summary Report Update (S15-122979)

Section 3-3 B of the FRAM Verification Summary report was including students with direct
certification for free and reduced price meals. Students with direct certification for reduced-priced
meals should not have been included. This issue was corrected and only students with direct
certification for free meals now report. Please note, this change impacts historical reporting. If you
run the Summary report for a prior year, the current report results may not match previous results.

Article(s): Step 7. Print the Summary Report (FRAM)

Path: FRAM > Verification

Summary Report Updates (S1S-125918)

The Section 4A number now only reflects applications submitted as of 10/1. Application changes
that occur after 10/1 will no longer impact Section 4A. The 3 numbers in Section 4A now equal the
total number of applications shown on the FRAM > Verification page.
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Article(s): FRAM (Free Reduced Application Management)

Path: FRAM > Verification

Grade Reporting

Grading Window - Notifications Warning (SIS-140073) [Enhancement]

A Grading Window Notifications Warning can now be sent to alert teachers and/or supervisors that
the Grading Window is closing soon and they have not yet posted grades for their course sections.

The Notifications feature released in Campus.2036 allows notices to be sent AFTER a Grading
Window has closed. This Warning feature can be used to send notices BEFORE a Grading Windows
closes.

Article(s): Grading Window Notifications

Path: Grading & Standards > Grading Window > Notifications > Send Warning

Grading Window - Update Script (SIS-140475)

An error related to date values has been corrected for when the script used to update to new
Grading Window tables runs.

Article(s): N/A

Path: N/A

Grading Window - Incorrect Date Display (SIS-140730)

When creating a new Grading Window or modifying an existing Grading Window, the incorrect date
of the window displayed in the tool, but was saved correctly in the database. This was due to the
day of month not being a valid day in the month in which the Grading Window was active (e.g.,
created in a month that has 31 days for a window that begins and ends in a month that has 30
days). This has been corrected.

Article(s): Grading Window

Path: Grading & Standards > Grading Window

Health
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Health Office Visits Fix (SIS-136287)

When a Treatment is ended or inactivated and there is a scheduled Health Office Visit using that
Treatment, a warning message should display telling the user to Remove or Delete the Health
Office Visit. This warning message was not displaying and has been fixed in this case.

Article: Health Office Visits

Path: Student Information > Health > General > Health Office Visits

Daily Health Log Update (SIS-140381)

The Comments field in the Daily Health Log has been updated to allow a maximum of 255
characters.

Article(s): Daily Health Log

Path: Student Information > Health > General > Daily Health Log

Learner Planning

Special Ed Caseload Sort Update (S1S-139646)

Sorting functionality has been added to the Special Ed Caseload tool.
Article: Special Ed Caseload

Path: Student Information > Special Ed > Caseload

Special Ed Team Members Performance Update (S1S-140368)

A performance issue with the Find and Link New Team Member function on the Special Ed Team
Members tool has been resolved.

Article: Special Ed Team Members

Path: Student Information > Special Ed > General > Team Members

Navigation

Household and Course/Section Search Panels Added to New Look of Infinite Campus (SIS-138378)

[Enhancement]

New Household and Course/Section context search panels have been added to the New Look and
Feel of Infinite Campus.

Now, users can access an intuitive search to find and select a household with the ability to
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navigate to Household, Person, and Address tools within results.

A course/section search was added, providing a simple way to search for and select sections and
courses within a single search display.

Article(s): Try the New Look of Campus

Path: No Specific Path

Classic Campus Navigation Working Incorrectly When District Announcement Contains Embedded
iFrame (SIS-140565)

District announcements containing an embedded iframe were causing some of the navigational
elements of Classic Campus to function incorrectly. This issue was corrected.

Article(s): N/A

Path: No Specific Path

OneRoster

OneRoster - Expiration Notifications (SIS-124095)

Process Alerts for expiring OneRoster tokens are now sent 14 and 7 days prior to the expiration
date. Users can renew tokens via the Digital Learning Applications Configuration tool (Learning
Interoperability in classic view).

Article(s): Learning Interoperability

Path: System Administration > Learning Interoperability; Process Alerts

OneRoster - datelastModified (S1S-140647)

The logic for dateLastModified in the studentEnroliments endpoint has been updated to report
correctly roster records previously reporting 01/01/1970 due to null values.

This case includes a long-running script that may extend deployments.
Article(s): OneRoster API

Path: No specific path

Online Payments

My Cart Checkout Screen Update (SIS-139701)
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Cosmetic updates were made to improve the appearance and usability of the Checkout screen in
My Cart.

Article(s): My Cart

Path: Campus Parent > My Cart, Campus Student > My Cart

Point of Sale

Mass Account Creation Update (S1S-118404)

The Mass Account Creation tool was not working for some districts because the tool was
attempting to assign a PIN that was already in use. This issue was corrected.

Article(s): Mass Account Creation (POS)

Path: Point of Sale > Account Maintenance > Mass Account Creation

Records Transfer

EL Import Update (SIS-64243)

The Records Transfer tool was previously allowing overlapping EL records to be imported. Now, if
the import’s EL record will overlap with an EL record in the receiving district's database, then the
import’s EL record will not be inserted. However, if there is no overlap/conflict, the import's EL
record will be inserted into the receiving district's database.

Article(s): N/A

Path: Student Information > General > Records Transfer

RTI
RTI Plan Fix (SIS-140242)

An issue with the Universal Screener Name attribute Data Type has been fixed (System
Administration > Custom > Attribute/Dictionary > Plan > Universal Screener Name).

Article: RTI Plan

Path: Student Information > Response to Intervention > General > Documents

Scheduling
Guest Access to Grade Book (SI1S-140621)

Previously, users were unable to access a section's grade book as a guest if a teacher was not
assigned to the section. This has been corrected.
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Article(s): Guest Access to Grade Book

Path: Scheduling > Courses > Section > Grade Book link

Walk-In Scheduler - Section Placement Error (SI1S-140838)

When a student is scheduled into a course section that does not have a section placement and the
course has a skinny scheduling rule, an error message displayed.

This has been corrected.

Sections that cannot be placed are now listed under a NO PLACED SECTIONS header on the
Requests panel. An error message also displays with these sections, indicating the course does not
have any sections or section placements or is scheduled into a different schedule structure.

Article(s): Walk-In Scheduler

Path: Student Information > General > Schedule > Walk-In Scheduler

School Choice
School Choice Reports Available in DOCX (SIS-127048) [Enhancement]
The following School Choice Reports can now be generated in DOCX format:

¢ Application Conflict
e Application Status

e Post Applications

e Process Applications

Article(s): Post Applications Wizard; Process Applications; Application Conflict; Application Status

Path: System Administration > School Choice > Reports > Application Status, Application Conflict;
System Administration > School Choice > Post Applications, Process Applications

School Store

Ability to View School Store Purchases in Census (SI1S-138893)[Enhancement]

The Payments tool in Census now provides detailed information about online payments, Food
Service deposits, School Store purchases, and office payments made for an individual person.

Article(s): Payments (People)

Path: Census > People > Payments
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New Option to Delete Unused Categories and Products (SI1S-138918) [Enhancement]

Users can now delete Categories if there are not any Products assigned and delete Products if
there are no sales attached. As part of this change, a new toggle called "Show Inactive" was added
to the Categories tool and the General Product tool. When the Show Inactive toggle is set to ON,
Campus will display inactive Categories or Products. Otherwise, when the toggle is set to OFF, only
active Categories and Products display.

Article(s): School Store

Path: School Store

Update for Including Multiple Schools in One Orders Report (SIS-139892) [Enhancement]

The Orders report can now be produced for multiple schools at one time. New options on the
report editor allow you specify which schools to include in the report. There are also formatting
options that allow you to group the report by School, School/Room Number, School/ltem, or by
Customer.

Article(s): Orders Report

Path: School Store > Reports > Orders

Partial Refunds for School Store Products (SIS-139945) [Enhancement]

Districts can now use the Payments Reporter to issue partial refunds for items purchased in the
School Store. As part of this change, a new checkbox called "Partial Refunds" was added to the
Product setup. When this checkbox is marked, partial refunds are allowed for that product. If the
item is an inventory tracked item, a new checkbox called "Return to Inventory" now displays when
completing a full or partial refund. When this checkbox is marked, Campus will return the item to
the product inventory.

Article(s): Payments Reporter, School Store

Path: System Administration > Payments > Payments Reporter; School Store > Product Inventory
> General Product

School Store Image Update (SIS-140334)

The School Store image in the Settings tool was not changing to each school’s image when a
different school was selected. This issue was corrected.

Article(s): School Store

Path: School Store > Administration > Settings
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School Store Reports Update (SI1S-140436)

The Pick List, Orders, Sales, and Inventory On Hand reports were only including 21 categories in
their report results. This issue was corrected and all categories are now included.

Article(s): Pick List, Orders, Sales, Inventory on Hand

Path: School Store > Reports

Purchase Limit Cache Update for Multiple Application Server Environments (SI1S-140466)

In multiple application server environments, if a purchase was made for a product with purchase
limits (both product and item), buying it again from another browser pointing to a different
application server allowed the user to purchase that item even though it had reached the purchase
limit. This issue was corrected.

Article(s): School Store

Path: School Store

School Store and Category Screen Restructure (SIS-140568) [Enhancement]

The following changes were made for the School Store.

e The School Store tools were moved out of System Administration to the top level in the Index.

¢ A new tool was added for managing School Store and Activity Registration Categories.
Previously, Categories for these modules were managed in seperate tools. The new
Categories tool can be found in School Store > Administration > Categories.

e A new menu item called Product Inventory was added. The Product Inventory menu includes a
new tool called "General Product" where Products are managed. Previously, Products were
managed by clicking the Products button on a Category. The Product Inventory menu also
includes the Activity Monitor for Activity Registration.

Article(s): School Store; Categories (School Store)

Path: School Store > Administration > Categories

New Warning when Importing File for Product Items (SIS-140674)

Campus allows you to import an Excel or CSV file to populate the Product Items table in the
Product progress tracker. At least one custom attribute column is required to add more than one
product item. Now, when a user tries to import a file with more than one item and no custom
attributes, Campus displays an error message.
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Article(s): School Store

Path: School Store

Search

Search Framework Error Process Alert Message (S1S5-129400) [Enhancement]

Users with a Student Information System (SIS) product security role will now receive a process
alert if an issue with the search framework occurs within their environment.

Article(s): N/A

Path: Process Alerts Editor

Search Framework Status Tool Now Available (S1S-130453) [Enhancement]

A new Search Framework Status tool is now available for SIS and Limited Edition product security
role users. This tool is primarily intended for Infinite Campus support personnel. The status page
provides a simplified way to quickly and easily identify the health and status of the search
framework within Infinite Campus. The status page details are only displayed on quartz enabled
Campus app servers.

The framework status is color-coded with a message describing the current health of your system.
Green means everything is working properly, blue is a warning that some issues have occurred but
the system is not down, yellow and red mean an error has occurred and the search framework is
not functioning properly.

For yellow and red statuses, please reach out to Infinite Campus for further support.
Article(s): Search Framework Status

Path: System Administration > Search Framework Status

Security

Audit Log Failing to Show Disabled or Change User Accounts (S1S-140009)

The Audit Log was failing to show when an account was disabled or changed via the User Account
Batch Wizard. This issue was corrected.

Article(s): User Account Batch Wizard

Path: System Administration > User Security > User Preference Management > User Account
Batch Wizard
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Disabled LDAPS Profiles Incorrectly Allowed to Connect (SIS-140718)

A bug was incorrectly allowing some disabled LDAPS profiles to successfully connect to Infinite
Campus. This issue was corrected.

Article(s): N/A

Path: No Specific Path

Student

Photo Import Producing Errors (SIS-129931)

Illegal characters in the database were causing the Photo Import tool to error out for some users.
This issue was corrected.

Article(s): Photo Import

Path: System Administration > Student > Photo Import

Surveys

Completely Redesigned Survey Designer Tool Now Available (SIS-137797) [Enhancement]

The Survey Designer tool has been completely redesigned to enhance usability and functionality
throughout. Users are now walked through the process using an intuitive wizard with the ability to
customize logic for each question and create questions using a powerful toolset.

Article(s): Survey Designer

Path: Surveys > Survey Designer

Transcript
Removal of Classic Transcript (SIS-140963) [Enhancement]

In a future release, the classic Transcript tool, available in Student Information > General >
Transcripts, will be removed from the product. A banner has been added to this tool in both the
classic navigation and in the new navigation to inform users of this change.

The enhanced Transcript, available in Student Information > Counseling > General > Transcript,
was released in the Campus.1745 Release Pack (November 2017). This Transcript tool will be
modified to include new features in future releases.

Articles(s): Transcripts (Student); Transcript (Counseling)

Path: Student Information > General > Transcript
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WYSIWYG Editor

WYSIWYG Editors - Pasting Text from MS Word (S1S-136180)

The option to paste text from a Microsoft Word document into a WYSIWYG editor now retains the
formatting for the following features:

Bold

Italic

Underline

Single level bulleted list
Single level numbered list
Tables

Formatting is NOT retained for the following features:

e Line spacing
e Font Color
e Font Size

e Alignment
e Sub-Lists

¢ Indent

Article(s): WYSIWYG Editors

Path: N/A

Localization

Arizona

Arizona - ESS DDC Extract Now Available (S1S-138747)

A new ESS DDC Extract is now available. This extract identifies students who are both designated
as Special Ed and have a qualifying set of behavior records tied to the selected calendar(s).

In conjunction with this new extract, the following updates were also made:

e State Event Code Mapping attributes were updated to meet state requirements.

e State Resolution Code Mapping attributes were updated to meet state requirements.

¢ Violation Level 1 and Violation Level 3 attributes were updated to meet state requirements.

e A script was implemented to convert existing Event, Resolution, and Violation 3 codes to the
updated attribute values.

NOTE: The following codes do not have a one to one conversion so will be scripted to map to "No
State Code Mapping". Districts will have to manually update their event types to the correct
matching state code. Likely, these codes are used in conjunction with the Violation Level 1 drop
down. If that is the case, then districts should map this to the 'Other State Reported Violation' state
event code. This event will likely need to be created at the district level for schools to use.
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e 22 - Theft

e 50 - Firearms

e 52 - Other Weapons
e 53 - Dangerous Items
e 57 - Drug Violation

These events are currently available in the Violation Level 1 drop down. Schools can continue to
use that drop down as long as the event assigned is tied to the 'Other State Reported Violation'
state event code. If they want more detailed reporting at the event level without having to go to a
sub category, they can create new events that are specific to each of these values.

e 88 - Theft - Non School Property

e 89 - Theft - School Property

e 90 - Destructive Devices e.g. Bomb or Grenade
e 91 - Handgun or Pistol

e 92 - Shotgun or Rifle

e 93 - Starter Gun or Pistol

e 94 - Air Soft Gun

e 95-B.B. Gun

e 96 - Knife with a blade at least 2.5 inches

e 97 - Laser Pointer

e 98 - Letter Opener

e 99 - Mace/Pepper Spray

e 101 - Paintball Gun

e 102 - Pellet Gun

e 103 - Razor blade/box cutter

e 104 - Simulated Knife

e 105 - Taser or Stun Gun

e 106 - Tear Gas

e 107 - Billy Club

e 108 - Brass Knuckles

e 109 - Knife with a blade length of less than 2.5 inches
e 110 - Nunchakus

e 111 - Inhalants

e 112 - Prescription Drugs (Inappropriate use of)
e 113 - Over the Counter Drugs ( Inappropriate Use of )
e 114 - Drug Paraphernalia

e 115 - lllicit Drug

e 116 - Substance represented as illicit drug

e 117 - Unknown Drug

e 119 - Serious Bodily Injury

A Most Severe checkbox has been added to the Behavior Event editor. Districts should go into
existing events and check this box where appropriate in order for it to report correctly.

A Duration in School Hours text box has been added to the Resolution Details editor. Districts must
go back and fill in this field where appropriate, otherwise 0 will report.

Article(s): ESS DDC Extract (Arizona)

Page 32


http://kb.infinitecampus.com/help/ess-ddc-report-arizona

Path: AZ State Reporting > ESS DDC Extract

Arizona - Attendance Extract Now Available (S15-139197) [Enhancement]

A new state reporting Attendance Extract is now available. This extract contains three reports
detailing student attendance:

e Distance Learning Summary - Provides distance learning statistics required by the State of
Arizona. Note, the percentages are calculated based on scheduled days, not scheduled hours

e Student Attendance Summary - Provides aggregate attendance totals per student in the
reporting calendar based on what was reported through Ed-Fi.

e Student Attendance Detail - Generates individual student attendance records for each
student based on what was submitted to the state.

Article(s): Attendance Extract (Arizona)

Path: State Reporting > Attendance Extract

Arizona - Ed-Fi v3.3 Student Special Education Program Association Update (S1S-140677)

The endDate logic in the Student Special Education Program Association (SSEPA) resource has
been updated to only look at overlapping enrollments in the same school and to account for null
enrollment end dates when enrollments are overlapping within the same school.

The MainSPEDSchool logic in the SSEPA resource has been updated to report 'True' for the main
enrollment if there are overlapping enrollments at different schools and to report ‘False’ for all
other enrollments.

The reasonExitedDescriptor in the SSEPA resource has been updated to report SPEDO5 when a
student has an End Status of W1 and there is not another consecutive enrollment in the same
school year, in the same school, that starts the very next instructional day.

The reasonExitedDescriptor has also been updated to report SPED09 when a student has an End
Status of W1 and there is another consecutive enrollment in the same school year, in the same
school, that starts the very next instructional day.

A resync needs to be completed on the Student Special Education Program Association resource
with this update.

Article(s): Arizona Ed-Fi v3.3 - Student Special Education Program Association

Path: System Administration > Ed-Fi

Arizona - Ed-Fi - New 21st CCLC Code (SIS-140772)
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The ‘21st CCLC Yr 5C’ program code has been made available for districts to use in the 2020-21
school year.

Article(s): Arizona Ed-Fi v3.3 - Student Program Associations

Path: System Administration > Ed-Fi

Bureau of Indian Education

The NASIS Tab has moved from Student Information > General to Student Information >
Program Participation > NASIS Programs. Please see NASIS Programs for more information.

BIE- New BIE Documents tab available (S5IS-133543) [Enhancement]

A new BIE Documents tab has been added to the NASIS Programs tool for BIE District Edition users.
With this tool, users are ONLY able to upload documents to individual student records and lock
those documents to prevent unauthorized changes. BIE Documents does not include options for
printing or adding interactive custom forms.

Users must be given the appropriate tool rights to view or interact with this tool. Users given Read
rights to the NASIS Programs tabset will be unable to view any uploaded documents unless given
an additional Read right to ‘Document Read’ under BIE Documents. Follow your standard tool right
policies and procedures when assigning rights to the BIE Documents tab.

Article(s): NASIS Programs

Path: Student Information > Program Participation > NASIS Programs > BIE Documents

BIE Special Ed Updates (SIS-139650)

In previous updates to core Special Ed tools, the Amend functionality was removed from Maine
BIE. With this update, the amend functionality has been restored for Maine BIE.

Article: Special Ed Tool Rights; Special Ed Preferences; Individual Education Plan (BIE)

Path: System Administration > Special Ed > Preferences; Student Information > Special Ed >
General > Documents

BIE Goal Monitoring Fix (SIS-140386)

An issue where the Goal Monitoring tool was not working with the BIE IEP 09 print format has been
fixed.

Article: Goal Monitoring
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Path: Student Information > Special Ed > General > Goal Monitoring

BIE Special Ed Setting Update (SIS-140502)

The options available in the Special Ed Setting dropdown on the IEP Enroliment Status editor and
the Enrollments tool have been updated.

Article: Individual Education Plan (BIE)

Path: Student Information > Special Ed > General > Documents; Student Information > General >
Enrollments

California

California - EL Services Update Script (SIS-140474)

An error related to date values has been corrected when the script used to update to new EL
Services tables runs.

Article(s): N/A

Path: N/A

California - New Program for Tribal Foster Youth (S1S-140671)

A new State Program, Code 193: Tribal Foster Youth, has been added to Flags.

CALPADS Student Programs has been modified to report this program. When generating the Fall
Collection, Code 193 reports, if selected. The following fields report information related to Code
193. See the article below for detailed reporting logic.

e Field 13, Education Program Code

e Field 14, Education Program Membership Code

e Field 15, Education Program Membership Start Date
e Field 16, Education Program Membership End Date

Article(s): CALPADS Student Program

Path: CA State Reporting > CALPADS Student Program

Colorado

Colorado Evaluation Update (S1S-139265)

An SSID text field has been added to the Evaluation Header on the Colorado Evaluation.
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Article: Evaluation (Colorado)

Path: Student Information > Special Ed > General > Documents

Colorado -Student Interchange - Course Completion (Colorado) (S1S-139312)

The Course Completion Extract has been modified to only report PSEO Programs when the Start
Date on the student's CEPA record is on or before the Effective Date entered on the extract editor
and the End Date on the CEPA record is blank or occurs within the reporting period.

The Post Secondary Participation and Institution Codes fields only report when the CEPA record
falls within the reporting period.

Article(s): Student Interchange - Course Completion (Colorado)

Path: CO State Reporting > Data Pipeline > Student Interchange > Course Completion

Colorado - VE-135 File - Program Level (S1S-140048)

The Program Level now reports a value of 1 for all records when generating the High School
format. When generating the Middle School format, a value of 5 reports for all records.

Article(s): VE-135 File (Colorado)

Path: CO State Reporting > VE-135 File

Colorado - Student Layout - Primary Nighttime Residence (S1S-140900)

Field 22, Primary Nighttime Residence, now reports a value of 00 when the student does not have
a Homeless record active during the reporting period.

Article(s): Student Interchange - Student Layout (Colorado)

Path: CO State Reporting > Data Pipeline > Student Interchange > Student Layout

Georgia
Georgia Evaluation Update (S1S-140190)

The Domain Area field from the Georgia Evaluation is now an editable Attribute in the Attribute
Dictionary at System Administration > Custom > Attribute/Dictionary > Evaluation > Domain Area.

Article: Evaluation (Georgia)

Path: Student Information > Special Ed > General > Documents > Evaluations
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Georgia IEP Bug Fix (SI1S-140587)

An error where the Meeting Date was printing as the IEP Implementation Date has been resolved.
Article: Individual Education Plan (Georgia)

Path: Student Information > Special Ed > General > Documents > Plans

Georgia IEP Update (SIS-140989)

When a user clicks "Review Amendment" and enters an Amendment Start Date, the date
automatically populates as the IEP Implementation Date under Education Plan upon save.
Validation has been added when a user clicks "Complete Amendment," the Meeting Date should
not fall after the IEP Implementation Date.

Article: Indibidual Education Plan (Georgia)

Path: Student Information > Special Ed > General > Documents

Hawaii

Hawaii - Gifted and Talented Documents (SIS-SIS-140599)
The Gifted and Talented Documents tool is now available for districts in Hawaii.
Article(s): Gifted and Talented Documents

Path: Student Information > General > Program Participation > Gifted & Talented > Documents

Hawaii - Adjudicated Source(s) (SIS-140701)

The following changes were made to the ALPSS tool.

¢ Adjudicated Source/Reported By textbox name was changed to Adjudicated Source Name(s).

¢ A new textbox comment field called Adjudicated Source Other Comment was added.

¢ A new multi-select field called "Adjudicated Source(s)" was added. This field displays with the
following options when the Adjudicated field is set to Yes.

e DHS Rep

e DOH Rep

e Family Court

e Foster Parent

e GAL

e Law Enforcement

e Parent/Guardian

e Parole Officer
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e Peer/Friend

e Probation Officer

e School Social Worker
e Self (student)

e Surrogate Parent

e Other

Article(s): Hawaii Alternative Learning Programs, Supports & Services (ALPSS)

Path: Student Information > General > Program Participation > ALPSS

Hawaii - New Fields on Impact Aid Report (S1S-140899)

The following fields are now available on the Impact Aid Report for districts in Hawaii: Branch,
Employment Type, End Status, Rank, and Status.

Article(s): Impact Aid Report

Path: Census > Reports> Impact Aid Report

Hawaii - GT Status Description Update (SIS-141021)

The GT status description was changed from "Gifted Talented" to "Gifted and Talented Status."
Article(s): Hawaii Gifted & Talented

Path: Student Information > General > Program Participation > Gifted & Talented

Idaho

Idaho - ISEE Staff Demographics Extract Update (S1S-140430)

The Staff Demographics extract has been updated to report the schoollD for teacher records that
don't have a District Employment record.

Article(s): Staff Demographics

Path: ID State Reporting > ISEE Extracts > Staff Demgoraphics

Idaho - Border Student Conversion (S1S-140476)

Updates have been made to the conversion script for Border Student data. Data is only converted
from the enrollment if a Border ID is entered and the Border Status is | or O. Logic for multiple
enrollments and dates is unchanged from the previous conversion script. No conversion is done if a
Border Student record already exists for the student.
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Article(s): N/A

Path: Student Information > Program Participation > Border Student

lllinois
lllinois - ISBE Regional Safe Schools Program (SI1S-136650)

A new ISBE Extract, called Regional Safe Schools Program, is now available. This extract reports
students who are participating in safe school programming.

A new Regional Safe School Program (RSSP) tool has been added to the Program Participation
State Programs to track a student's participation in safe schools programming.

Article(s): ISBE Regional Safe School Program

Path: IL State Reporting > ISBE Extracts > Regional Safe School Program

lllinois - State Reporting Removed/Renamed Extracts (SIS-138958)

The following extracts are no longer collected by the State of lllinois and have been removed from
the IL State Reporting folder:

e Assessment Correction Extract
General State Aid Extracts

School Report Card

IAR Assessment Correction Extract
ACT Pre-ID Extract

The following extracts have been renamed:

e Year End Collection is now End of Year Report. The End of Year Summary and End of Year
Detail Report have been removed

e K-12 In Progress/PARCC V2 is now K-12 In Progress V2.

e ELL Screener is now EL Screener.

Article(s): lllinois State Reporting

Path: IL State Reporting

lllinois - ISBE Gifted and Accelerated - Home School (SIS-139484)
The Home School Field (field 6) now reports the RCDTS value, instead of reporting blank.

Article(s): ISBE Gifted and Accelerated

Path: IL State Reporting > ISBE Extracts > Gifted and Accelerated
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lllinois - EL Service Types (SIS-139744)

EL Service Type 13: 13 Other/Alternative has been renamed to 13: 228.27 Plan.

Article(s): EL Service Types

Path: Program Admin > EL Setup > EL Service Types > EL Service Types Detail

[llinois - New Language Codes (SIS-140268)
The following Language Codes can now be selected from the Home Primary Language field:

e 194: Geser-Goram (ges)
e 195: Tajik (taj)

Article(s): Demographics

Path: Census > People > Demographics

Indiana
Indiana - TA Extract Update (SIS-135198)

An error was displaying for users when trying to run the TA extract. This issue was corrected. As
part of this change, the TA report was updated to accept alphanumeric values from the Test Score
Result field (Student Information > General > Assessments > LEP > Result).

Article(s): TA (Test Accommodations Report) (Indiana)

Path: IN State Reporting > TA

Indiana - GR (Graduate Report) Update (SIS-139176)

The report logic for the GR report was updated to only report one record per student regardless of
how many calendars the student is in or how many calendars the school has.

Article(s): GR (Graduate Report) (Indiana)

Path: IN State Reporting > GR

Indiana - ME Report Update for Reporting COVID-19 Virtual (S1S-139508)

A new field called "Distance Learning" was added next to the Virtual Student percentage field in
the Enrollment State Reporting area. When this field is populated and there is a value in the Virtual
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Student field of 50 or more, *C* (COVID-19 Virtual) now reports on the ME report in the Virtual
Student field.

Article(s): ME (Membership Report) (Indiana

Path: IN State Reporting > ME

Indiana - Changes for West Clark District Separation (S1S-140064)

To support West Clark 0940 separating into two school districts, the following fields were updated
to support new District 455 and District 454 so their IDs are available in the dropdown list for
Enrollments in the 20-21 school year.

e Corporation of Legal Settlement
e Serving District
e Resident District

West Clark 0940 name and ID were removed.
Article(s): N/A

Path: Student Information > General > Enrollment > State Reporting Fields

Indiana - Digital Equity (S1S-140493)

Digital Equity was added to the Federal Programs in the Federal/State Program Updater.

Article(s): Federal/State Program Updater

Path: Program Admin > Federal/State Program Updater

Kansas

Kansas - Migrant Logic on KCAN Extract (S1S-140302)

Logic for reporting Migrant information has been modified to report a value of 1 when a student's
Migrant End Date is after the Effective Date entered on the Extract editor, as long as the Migrant
Start Date is before the Effective Date.

Article(s): KIDS KCAN Extract

Path: KS State Reporting > KCAN Extract

Kansas - Start/End Dates on Student Migrant Tool (SIS-140768)

The Start and End Date fields on the Migrant tool now display.
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Article(s): N/A

Path: Student Information > Program Participation > Migrant

Kentucky

Kentucky - EL Documents Custom Forms Module Added (SIS-133754) [Enhancement]

A new custom forms module called EL Documents has been added to Kentucky State and District
Editions of Campus. This module is accessible under Student Information > Forms for District
Users with rights to view documents associated with the new custom forms module. EL Documents
will house a new state-flagged interactive PDF form called ‘Program Services Plan (PSP) for English
Learners’. State-flagged forms will sync via DIS from districts to the State Edition.

Article(s): EL Documents - Custom Module (Kentucky)

Path: System Administration > Custom > Custom Forms

Kentucky Custom Form Updates (S1S-139752)

The following Medicaid custom forms have been updated in the Special Ed Documents tool and
added to the Health Documents tool:

e Medicaid Annual Parent Notification
e Medicaid Annual Parent Notification - Spanish

These custom forms have been added as both Blank and Interactive Forms.
Article: N/A

Path: Student Information > Special Ed > General > Documents; Student Information > Health >
General > Documents

Kentucky - Student Participation Report Now Available (S15-140250)

A new Student Participation Report is now available. This report details student participation and
engagement when they are taught in-person, remotely, via virtual/performance-based courses, or
in a hybrid blended learning model.

Article(s): Student Participation Report (Kentucky)

Path: KY State Reporting > Student Participation

Kentucky - Duration in School Days Not Auto-Calculating (SIS-140551)
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The auto-calculated value for Duration in School Days for Behavior Resolutions with Start and End
Dates/Times was failing to calculate and populate a value on resolutions. This issue was preventing
users from being able to save new behavior resolution records. This issue was corrected.

Article(s): Behavior Editors (Kentucky)

Path: Behavior > Behavior Management

Kentucky - Users Unable to Save TEDS Records (SIS-140682)

A bug was preventing users from properly saving TEDS records. This issue was corrected.

Article(s): TEDS (Kentucky)

Path: Student Information > General > TEDS

Maine
Maine - 2020-2021 School Year Updates (SIS-137005)
The following updates were made to meet 2020-2021 state requirements:

e End Status Type code ‘01931: Not enrolled, unknown status’ has been deactivated.

e The Refugee Flag and US School Date fields have been removed from the Student Personal
Report.

e The US School Date field has been added to the English Learners Report.

e Behavior Incident Type ‘DrugRelatedwMarijuana’ has been added.

e The Other Consequences field has been removed to the Behavior Report.

e The Satellite Program field was added to the CTE Report.

Article(s): Student Personal Report (Maine); English Learners Report (Maine); Behavior Report

(Maine); CTE Report (Maine)

Path: ME State Reporting > Student Personal Report, English Learners Report, CTE Report,
Behavior Report

Maine Immunization Update (SIS-140552)

The Meningococcal vaccine immunization compliance rules have been updated for Maine
Article: Maine Immunization Rules

Path: System Administration > Health > Vaccines

Maryland

Maryland - Non-Binary Gender (S1S-140325)
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The Gender and Legal Gender fields in Census > People > Identities now include "X: Non-Binary".
Article(s): N/A

Path: Census > People > ldentities

Maryland - Student Record Card 3 and MHSA Field Update (S1S-140626)

The attributes on the MD Calculated Assessment Statuses that currently contain code "18: Non-
Diploma/Certificate of Completion Student" were updated. The updated description is now "Not
Required for Graduation." The short description for code 18 was also changed from "Certificate" to
"Not Required."

Article(s): Student Record Card 3 (Maryland)

Path: Student Information > General > Calculated Assessment Statuses; MD State Reporting >
Student Record Cards

Massachusetts

Massachusetts - 2020-2021 Updates (SIS-138465)

In an effort to meeting 2020-2021 state requirements, the following updates were made:

e Program Admin >English Learners (EL) > EL Setup > EL Service Type '02: Two-Way Bilingual’
was changed to '02: Dual Language Education’.
e Verbiage for EL Service Type 03 has been updated to ‘Other bilingual instructional program
for English learners (not Dual Language Education or Transitional Bilingual Education)’
e The following Enrollment > Chap 74 Approved Program Codes were added:
o 470607 - Aviation Maintenance Technology
o 480510 - Advanced Manufacturing Technology
e Enrollment > Chap 74 Approved Program Code ‘480501 Machine Tool Technology’ is no
longer active but remains in the database for historical and ad hoc reporting purposes.
¢ The following Non Chap 74 Program Codes are no longer active but remain in the database for
historical and ad hoc reporting purposes.
o 0159 - Animal Science
o 1241 - Cosmetology
e Employment Assignment > Assignment Code 016 has been renamed to ‘016: Core - Bilingual
Education Teacher - Language Other than English’
e Employment Assignment > Assignment Code ‘017: Core - Bilingual Education Teacher -
English' has been added.
¢ he following checkboxes have been added to the State Reporting Fields section of the
Enrollments tool:
o Grade 8 Civics Project Complete
o Grade 9-12 Civics Project Complete
e The Retaliation-Related checkbox has been added to the behavior Event Details editor
(Behavior Management > Incident > Event > Event Details)
e The Pathways Course checkbox has been added to the Course Information (Course/Section >
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Course tab > Course Information) and Course Master Detail editors (Course Master > Course
Master Info tab > Course Master Detail)

Article(s): Massachusetts Enrollments Tab

Path: Behavior Management > Incident > Event > Event Details; Student Information >
Enrollments; Course/Section > Course tab > Course Information; Course Master > Course Master
Info tab > Course Master Detail; Program Admin >English Learners (EL) > EL Setup > EL Service

Type

Massachusetts - 2020-2021 SIF Updates (S1S-140482)

The following SIF updates were made:

e StudentSchoolEnrollment/[@Name="CivicsProjectCompleter"] was added.

e StudentSchoolEnrollment/[@Name="InstructionMode"] was added.

e StudentSchoolEnrollment trigger logic was updated to trigger a Change when the Instruction
Mode is added or changed to a different value. This is determined by Instruction Mode added
to State Programs.

e Logic for the StudentAttendanceSummary/DaysAttended element has been updated to the
following:

o Report the number of instructional days the student was enrolled and was attending in
person for MINUS the number of instructional days the student was attending in person
with unexcused absent days and excused absent days as of the State Reporting Date.

e Logic for the StudentAttendanceSummary/ExcusedAbsences element has been updated to
the following:

o Count the number of days where a student is attending in person and has an Attendance
Code with the Status of "Absent" and the Excuse of "Excused" where they have been
marked for over Half Day minutes set on the calendar as of the State Reporting Date.

e Logic for the StudentAttendanceSummary/UnexcusedAbsences element has been updated to
only report unexcused absences for days the student attended in person.

e The StudentAttendanceSummary/DaysAttendedRemote and
StudentAttendanceSummary/DaysAbsentRemote extended elements were added.

e The StudentSectionEnrollment/[@Name="PathwaysCourse"] extended element was added.

e The Disciplinelncident/[@Name="Retaliation"] extended element was added.

e A new trigger was added to the SectionInfo object to trigger a Change if the College/Virtual
Institution is added or changed.

Article(s): SIF (Massachusetts)

Path: No Specific Path

Massachusetts Immunization Update (SIS-140501)

The Meningococcal and Influenza vaccine immunization compliance rules have been updated for
Massachusetts.
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Article: Massachusetts Immunization Rules

Path: System Administration > Health > Vaccines

Massachusetts - MA Instruction Mode Tool Added (SIS-140833)

A new tool called MA Instruction Mode has been added to Student Information > Program
Participation > State Programs. This new tab allows districts to manage student instruction modes
and pass this information to the State via the SIF StudentEnrollment object.

Article(s): MA Instruction Mode (Massachusetts)

Path: Student Information > Program Participation > State Programs > MA Instruction Mode

Michigan
Michigan - Ed-Fi v3.1 Update (SIS-135218)

The Ed-Fi configuration has been updated to version 3.1 to allow districts to report data for the
2020-21 school year.

Article(s): Michigan Ed-Fi v3.1, Michigan Ed-Fi Configuration

Path: System Administration > Ed-Fi

Michigan - Student Record Maintenance Updates (SIS-138870)

A new field called TuitionFundedEnroliment has been added to the Membership component of the
Student Record Maintenance extract. The EarlyOn field has been removed.

Article(s): SRM

Path: M| State Reporting > MSDS Extracts > Student Record Maintenance

Minnesota

Minnesota Evaluation Type Added (S1S-139485)

A new Special Ed Evaluation type, Functional Behavior Assessment, has been added for Minnesota.
This format can be completed as a stand-alone Evaluation or as part of a comprehensive
Evaluation.

Article: Functional Behavior Assessment (Minnesota)

Path: Student Information > Special Ed > General > Documents
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Minnesota - Ed-Fi Student Early Education Program Associations Resource Update (SIS-140308)

The Student Early Education Program Associations resource has been updated to report the
servedOutsideOfRegularSession and serviceMembershipHours elements correctly.

A resync on the Student Early Education Program Associations resource needs to be completed
with this update.

Article(s): Minnesota Ed-Fi v3.1 - Student Early Education Program Associations

Path: System Administration > Ed-Fi

Minnesota - Updated District List (SIS-140670)

The list of MN districts has been updated to include the Rock Ridge Public Schools district.
Article(s): Other Districts

Path: System Administration > Resources > District Information > Other Districts

Missouri

Missouri - MOSIS Student Enrollment and Attendance (SI1S-139802)

Field 125, Entry Date, and Field 135, Exit Date, are now required for the August Reporting Period.
These fields are included when the Optional Fields Allowed checkbox is marked and when it isn't
marked.

Article(s): MOSIS Student Enrollment and Attendance

Path: MO State Reporting > MOSIS Extracts > Student Enroliment and Attendance

Missouri - MOSIS Student Core Extract - Teacher Name (SIS-139983)

Field 45, Teacher Name, was causing the MOSIS Student Core Extract to time out when generating
when the Optional Fields Allowed checkbox was marked. This has been corrected by truncating the
number of characters of a teacher's name to be 40 characters.

Article(s): MOSIS Student Core

Path: MO State Reporting > MOSIS Extracts > Student Core

Missouri - MOSIS Student Core, New Digital Equity Tool (SIS-140099)

A new Digital Equity tool is available to track a student's access to technology used for
distance/remote learning. The MOSIS Student Core Extract has been updated to report fields from
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the Digital Equity tool (fields 334, 335 and 336).

A new PK Replacement ID field has been added to the State Reporting Enrollment editor. This
reports in field 337 on the MOSIS Student Core Extract.

Also on the MOSIS Student Core Extract, Field 333, CTE Certificate, only reports a value of Y or N
when the the student's Career Ed field has a value of CHS or CNP and an Enrollment End Status of
GO1 or GO3.

Article(s): Missouri Digital Equity, Missouri Enrollments, MOSIS Student Core

Path: Student Information > Program Participation > State Programs > Digital Equity; Student
Information > General > Enrollments; MO State Reporting > MOSIS Extracts > Student Core

Missouri IEP Updates (S1S-140309)

Several updates have been made to the Missouri IEP, including:

¢ a new print format, MO IEP 2020.2, is now available.
e additional verbiage has been added to the PLAAFP editor.
e options for distance learning have been added to the Special Considerations editor.
¢ the State Assessment Participation editor has been heavily updated with new verbiage and
options for each section on the editor.
e several updates have been made to the Grade-Level Assessment Accommodations editor,
including:
o updated verbiage.
o the Type dropdown options have been updated.
o validation has been added to display different fields depending on which Type is
selected.
¢ several updates have been made to the End-of-Course (EOC) Assessment Accommodations
editor, including:
o updated verbiage.
o the Type dropdown options have been updated.
o validation has been added to display different fields depending on which Type is
selected.
e verbiage on the Alternate Assessment (MAP-A) editor has been updated.
e several updates have been made to the ACCESS for ELLs editor, including:
o the Accommodations dropdown options have been updated.
o validation has been added to display different fields depending on which
Accommodation is selected.
e a new editor, NAEP/International Assessments, is now available.
¢ a new editor, Form G: Sections A & C, is now available.
¢ a new editor, Form G: Section B - Services, is now available.
¢ a new editor, Form G: Section B - Accommodations/Modifications, is now available.
e a new editor, Form G: Parent Contact Log, is now available.
¢ a new editor, Form G: Log of Date(s) of Closure, is now available.

The Discipline Documentation Form and Form G - Distance Learning Log Custom Forms have also
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been updated.
Article: Individual Education Plan (Missouri)

Path: Student Information > Special Ed > General > Documents

Missouri - UniguelD Extract School Code (SIS-140700)

The UniquelD Extract now reports the Current School Code (field 2) from the Attending School
Code field on the State Reporting Enroliment editor. If that field is not populated, the State School
Number reports.

Article(s): UniquelD Extract

Path: MO State Reporting > UniquelD Extract

Montana

Montana - MT Data Upload Validation Message Updated (SIS-138824)

The import error message for when the importing school number is not within the importing
district number has been updated to state "School number (S###) does not exist within district
number (D###)". This update impacts the following files:

e AA - End of Year Attendance Totals

e AF - Fall Enrollment Count

e AS - Spring Enrolliment Count

e AT - Test Window Enrollment Count

e CT - Career and Technical Education (CTE)
e EN - Student Enroliments

e PP - Program Participation

The error message for the Student Demographic file for when the district number does not match
the importing district has been updated to state "District number (D###) in this file does not
match the current district number."

The error message for the English Learner (EL) file for when the importing statelD does not match
a currently enrolled status has been updated to state " StatelD does not match a student currently
enrolled in district number (D###)"

Article(s): MT Data Upload

Path: MT State Reporting > MT Data Upload

Montana State Reported Data State Edition Update (SIS-138833) [Enhancement]

The New button on the Montana State Edition State Reported Data tool is now grayed out.
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Article: State Reported Data

Path: Student Information > Special Ed > General > State Reported Data

Montana - Upload Date Added to Person Picture (S1S-139004)

A read-only photo date field will now appear below photos within the Summary and Demographics
tools. This field has also been added to Ad hoc (PersonPicture.photoDate).

Article(s): Demographics

Path: Census > People > Demographics

Montana - MT Data Upload Store Location Producing Error (SIS-139097)

An issue with where files are stored via the MT Data Upload was causing users to receive an error
when attempting to use the Retrieve New Student State ID File process. This issue was corrected
and files are now properly stored in a shared cloud location.

Article(s): MT Data Upload

Path: MT State Reporting > MT Data Upload

Montana - Enrollment Screen and State Reporting Updates (S1S-139670)

The following updates were made to the Enrollments editor:

e The Military Connected Status header is now in all caps.
e A horizontal line has been added to separate the Military Connected Status and Enrollment
Details sections.
e An Enroliment Details heading has been added.
e The Attendance Count and Enrollment Count headings have been replaced with:
o Fall Enrollment Count
o Spring Enrollment Count
o Test Window Enrollment Count
e The Indian Lang. Immersion Prg field has been moved under the Fall Enroliment Count area.
e The Spring Absent and Testing Absent fields have been added.

The Spring Count Absent field has been added to the Spring Enrollment Count Import and Export
files.

The Test Window Count Absent field has been removed from the Test Window Enrollment Count
Import and Export files.

The Count Date Attendance tool has been updated to calculate Spring Absent Attendance and the
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calculation for Testing Absent has been deprecated.

Article(s): Count Date Attendance (Montana); Spring Enrollment Count Extract (Montana); Test
Window Enrollment Count Extract (Montana)

Path: MT State Reporting > MT Count Date Attendance; MT State Reporting > MT Extracts >
Extract Type > Spring Enroliment Count; MT State Reporting > MT Extracts > Test Window
Enrollment Count

Montana Special Ed IEP Updates (SIS-140161)

The list of accommodations on the Statewide Assessments editor of the Montana IEP now displays
alphabetically.

A small print fix was also implemented to properly align the checkboxes on the Prior Written Notice
section.

Article: Individual Education Plan (Montana)

Path: Student Information > Special Ed > General > Documents

Montana Special Ed Custom Forms Updates (SIS-140453)

The Consent to Bill Medicaid and MT CAS Form Custom Forms have been updated for Montana.
Article: N/A

Path: Student Information > Special Ed > General > Documents

Montana - Product Security Role Report to Include Montana Edition Details (SIS-140484)

The Product Security Role Report has been updated to include a definition for the Montana Edition
Product Security Role.

Article(s): Product Security Role Report

Path: System Administration > User Security > Reports > Product Security Role Report

Montana Edition State Reported Data Script (SIS-140810)

A script has been run on the Montana Edition to remove the end date from records that match the
following criteria:

e No modifiedBy ID exists on the record within the State Reported Data Tab.
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e A 19-20 Enrollment Record has an End Date that matches the end date of the State Reported
Data Record. This end date should be in the calendar year of 2020.
e A 20-21 Enrollment Record exists.

If multiple records exist, only the most recent record has had the date removed.

Article: State Reported Data (Montana)

Path: Student Information > Special Ed > General > State Reported Data

Nebraska

Nebraska - Ed-Fi Discipline Duration Update (SI1S-139776)

The Discipline Duration field for a Behavior Resolution has been updated to report to the
hundredths place. The disciplineActionLength and
disciplineActionLengthDifferenceReasonDescriptor elements in the Discipline Actions resource has
been updated to report the full value of the discipline duration.

A preference to turn on the auto calculation for the Discipline duration has been added to the
System Preferences tool.

Article(s): Nebraska Ed-Fi v3.1 - Discipline Actions

Path: System Administration > Ed-Fi; Student Information > General > Behavior > Behavior
Management > Incident> Resolution; System Administration > Resources > Preferences > System
Preferences

Nebraska - School of Assignment and Home School Fields Updates (S1S-140339)

The School of Assignment and Home School fields on the Enroliments tool have been updated to
report the State School Number instead of the SchoollD.

Article(s): N/A

Path: Student Information > General > Enrollments

Nevada

Nevada - Start Status and End Status Codes (S1S-139574)

Local Start Status codes and End Status codes are now in alphanumeric order on the student
Enrollment tab.

Article(s): Enrollments

Path: Student Information > General > Enrollments
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New Mexico

New Mexico - 20-21 State Programs and Programs Fact Changes (S1S-139660)

The Programs Fact Template and Programs Services Fact Template were updated to match 20-21
state requirements. As part of this change, the Program Participation > State Programs >
Extended Learning tool was updated to include new Expanded and Enriched Learning Time and
Opportunities data collection.

Article(s): Programs Fact Template (New Mexico); Programs Services Fact Template (New Mexico)

Path: NM State Reporting > PROGRAMS_FACT; PROGRAMS_SERVICES_FACT

New Mexico - Report Updates for 2020-21 School Year (S1S-139661)

The Student Template & Student Snapshot Template was updated to report the new BEP Program
Language field based on the student's Home Primary Language. The Student Infraction Response
Template was updated to report the new Administrator ID field from the Behavior Admin Staff
Name on Resolution.

Article(s): Student Template & Student Snapshot Template (New Mexico); Student Infraction &
Student Infraction Response Templates (New Mexico)

Path: NM State Reporting > Student & Stud_Snapshot; NM State Reporting > STUD_INFRACTION &
STUD_INFR_RESP

New York

New York - CTE Program CHAMP Added to State Program Code (SIS-139799)

The CTE program *CHAMP* was added to the State Program Code attribute in the attribute
dictionary. CHAMP can now be flagged as a state program.

Article(s): Attribute Dictionary

Path: System Administration > Custom > Attribute/Dictionary > Program > State Program Code

New York Immunization Update (S1S-140010)

The following vaccine immunization compliance rules have been updated for New York:

e Meningococcal
Polio

Varicella
Hepatitis B
DTaP

Article: New York Immunization Rules
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Path: System Administration > Health > Vaccines

New York - State Program Code 1232 Added (SI1S-140113)

State Program code 1232 (SIEF) - Student with Inconsistent / Interrupted Formal Education was
added to the Attribute Dictionary.

Article(s): Attribute Dictionary
Path: System Administration > Custom > Attribute/Dictionary > Program > State Program Code
Ohio

Ohio - Test Type IPD (SIS-139200)

The description for the Test Type of IPD has been updated.
Article(s): N/A

Path: Student Information > General > Assessment > Required Test Type

Ohio - Birth Country List (S1S-139563)

The Philippines has been added to the Birth Country code list.
Article(s): People

Path: Census > People > Demographics > Birth Country

Ohio Special Ed Update (SI1S-140129)

An issue where a warning message remained on the screen after saving a Prior Written Notice,
preventing any further action, has been fixed.

Article: N/A

Path: Student Information > Special Ed > General > Documents

Pennsylvania

Pennsylvania IEP Update (SIS-140382)

The Cycle option has been added as an option under Frequency to the Service editors on the
Pennsylvania IEP.

Page 54


http://kb.infinitecampus.com/help/attribute-dictionary
http://kb.infinitecampus.com/help/demographics-d597d2f

Article: Individual Education Plan (Pennsylvania)

Path: Student Information > Special Ed > General > Documents

Pennsylvania - State Reporting, Enrollment Updates (S15-139858)

The following modifications have been made to Pennsylvania specific fields:

e The Act 16 Funding descriptions (Student Information > General > Enrollments > Special Ed
Fields) have been updated.

e The list of Home Languages (Census > People > Demographics)have been updated for the
new school year.

e Code 75: Career and Technical has been added to the Delivery Method field (Student
Information > General > CTE).

e Code 1111: Blended/Hybrid has been added to the Delivery Code field on the Course editor
(Scheduling > Courses > Course).

e A Section Delivery field has been added to the Course Section editor (Scheduling > Courses >
Course > Section). This indicates how the information in the course was taught to the
students and includes the same options as the Delivery Code field on the Course editor.

The PIMS Student Course Enroliment Template has been modified to report Course Delivery Model
Code (field 15) from the Delivery Method field on the Section editor first. If that field is not
populated, it reports from the Delivery Method field on the Course editor.

The PIMS Incident Offender Template has been modified to now report the Injury Severity Code in
field 17. This reports from the Injury field on the Participant Details editor of a Behavior Event.

Article(s): Pennsylvania CTE; PIMS Student Course Enroliment Template; PIMS Incident Offender
Template

Path: PA State Reporting > PIMS Reporting > Student Course Enrollment, Incident Offender

Pennsylvania Immunization Update (SIS-140529)
The Tdap vaccine immunization compliance rules have been updated for Pennsylvania.
Article: Pennsylvania Immunization Rules

Path: System Administration > Health > Vaccines

Rhode Island

Rhode Island - State Attendance Codes (SIS-140624)
State Attendance Codes have been updated for the 2020-21 school year.

Article(s): Attendance Codes
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Path: System Administration > Attendance > Attendance Codes > State Code

Rhode Island - New Program Codes for 2020-21 (SIS-140931)

New Program Codes are now available. The Program Status Extract has been modified to report
these new codes (Field 6, Program Code).

e 4110: Distance Instruction
e 4111: Hybrid Model Instruction
e 4112: In School Instruction

Article(s): Program Status Extract

Path: Rl State Reporting > Enroliment Census > Program Status

Rhode Island - Enrollment Census Core - School Home Field (SIS-141074)

Field 42, SCHOOL_HOME, has been renamed to SCHCODE_HOME on the Enrollment Census Core
Extract.

Article(s): Enrollment Census Core (Rhode Island)

Path: RI State Reporting > Enrollment Census > Enroliment Census Core

South Dakota

South Dakota Immunization Update (SIS-140165)

The Varicella vaccine immunization compliance rules have been updated for South Dakota.
Article: South Dakota Immunization Rules

Path: System Administration > Health > Vaccines

Tennessee

Tennessee - EIS 060 & 062 Updates (SIS-140620)

The 060 and 062 extracts have been updated so that staff members are no longer required to be
marked as a Teacher in their District Assignment to report. District-wide staff are reported if they
have a District Assignment with a State School Number of 9999.

Article(s): 060, 062

Path: TN State Reporting > EIS Batch Transmission > 060, 062
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Texas

Texas-Blended Learning ‘Remote Learning Type' field added to the Group Day Rotation screen for
TX only (SIS-140000)

A new ‘Remote Learning Type’ field has been added to the Group Day Rotation screen to
accommodate 20/21 TX State reporting for attendance. This field is only available to Texas users
and is required before advancing to the next screen in the group setup process.

When creating a new group, two Remote Learning Type options are available for selection to
identify the delivery method used for instruction.

e Remote Synchronous - users should select this option for scheduled, real-time instruction
when students are not on campus. Daily attendance is based on scheduled instruction time.

e Remote Asynchronous - users should select this option if the instruction the group is receiving
is not in-person or in real-time when students are not on campus. Daily attendance is based
on the instructional plan and tasks the student performs.

Article(s): N/A

Path: Scheduling > Blended Learning > New Blended Learning Groups > Group Day Rotation

Texas- 20/21 Crisis Reporting updates with new Crisis Event tab (S1S-140519)

The Crisis Code field found in the Enrollment editor has been removed and relocated to the State
Programs tabset under Student Information > Program Participation. Crisis codes recorded on the
Enrollment editor for the 20-21 school year were successfully converted to the new Crisis Events

tab.

Users must be given the appropriate tool rights to view or interact with this tool. Follow your
standard tool right policies and procedures when assigning rights to the Crisis Events tab.

The following changes have also been made to Submissions 1, 3 and 4 of the Student Interchange
TSDS extract:

e Logic has been updated to include a Crisisimpacts complex type
e Logic has been updated to the TX-Crisisindicator element

Article(s): N/A

Path: Student Information > Program Participation > State Programs > Crisis Event

Utah
Utah - SIF Updates (SIS-137415)
The following updates have been made to SIF reporting for Utah:

e Logic for reporting the CalendarSummary object has been updated now allow one
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CalendarSummary object to be provided per school, rather than per district and to consider a
Sequence of null as the lowest Sequence.
e The header has been removed from Request files for the SSID Request Extract.
e Logic for the following elements has been updated to report correctly:
o Schoollnfo/ScheduleDayType
o Schoollnfo/SessionType
o SectionInfo/LocationOfInstruction/Code
o StudentSchoolEnrollment/FTPTStatus
o StudentPersonal/ReadGradelevel, /ReadGradelevelFall, /ReadGradelLevelSpring,
/BeginYearROGLCompositeScore, /MidYearROGLCompositeScore, and
/EndYearROGLCompositeScore.

Article(s): N/A

Path: No Specific Path

Utah - Start/End Dates on Student Migrant Tool (SI1S-140768)

The Start and End Date fields on the Migrant tool now display.
Article(s): N/A

Path: Student Information > Program Participation > Migrant

Utah - SIF StudentAcademicRecord Performance Issue (SIS-140868)

A bug was causing system performance issues when a batch sync for the SIF
StudentAcademicRecord was submitted for all calendars in the current year. This issue was
corrected.

Article(s): N/A

Path: No Specific Path

Vermont

Vermont - Homeless Data Added to Ad Hoc (S1S-134999)

The following Homeless Detail fields can now be retrieved in Ad hoc reporting (Student > Learner
> Homeless).

Start Date

End Date

Homeless Nighttime Residence
Unaccompanied Youth
Mckinney-Vento
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Article(s): N/A

Path: Student Information > Program Participation > Homeless
Virginia

Virginia- Update for Default Template on Transcript (SIS-139868)

An error displayed when users selected the Default transcript on the Transcript tab. This issue was
corrected.

Article(s): N/A

Path: Student Information > General > Transcripts

Wisconsin

Wisconsin - Ed-Fi School ID Removal (S1S-136090)

The schoollD has been removed from reporting in the incidentldentifier for the Discipline Actions
and Student Discipline Incident Association resources.

A resync on the Discipline Actions and Student Discipline Incident Association resources needs to
be completed with this update.

Article(s): Wisconsin Ed-Fi v3.3 - Discipline Actions, Wisconsin Ed-Fi v3.3 - Student Discipline
Incident Associations

Path: System Administration > Ed-Fi

Wisconsin - Ed-Fi Digital Equity Update (SIS-140427)

The Ed-Fi value reported for the 'Yes - Internet Access in Residence’ value in the Internet Access in
Residence field on the Digital Equity tool has been updated to report ‘Yes'.

A resync on the Student Education Organization Association resource needs to be completed with
this update.

Article(s): State Programs (Wisconsin)

Path: Student Information > Program Participation > State Programs > Digital Equity

Wisconsin - State Reporting Fields and Validations Added to Student Locator (SIS-140511)

All state reporting fields found on the Enroliments tab have been added to the Student Locator
tool.
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Also, the State Enrollment Type field is required when using the Student Locator.
Article(s): Wisconsin Enrollments; Student Locator

Path: Student Information > Student Locator; Student Information > General > Enrollments

Wisconsin - WISEid Import (SIS-141070)

The WISEid Import has been modified to match student records for the birth date field with or
without a leading zero in the month. This means that a birthday of January 10 will match as
01/10/2014 and as 1/10/2014.

Article(s): WISEid Import

Path: WI State Reporting > WISEid Import

Wyoming
Wyoming - Learning Methods (S15-140869)

The LMS Platform code list on the Learning Methods tab has been updated to add OT: Other and
deprecate CA2.

Article(s): N/A

Path: Scheduling > Courses > Course > Learning Methods
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